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1.  Wst � p
JTAG-lock-pick  to JTAG do procesorów z rdzeniem ARM pod
� czany do komputera PC przez ma-
gistral�  USB. Urz� dzenie oparte jest o uk
ad  FTDI FT22321, czyli dwukana
owy konwerter  USB 
<=> UART/FIFO. Zaprojektowany uk
ad na pierwszym kanale udost� pnia interfejs  JTAG, nato-
miast na drugim pe
ny interfejs  UART / RS-232 (RXD,  TXD,  RTS,  CTS,  DCD,  DSR,  DTR,  RI) z 
mo� liwo� ci�  do
� czenia konwertera RS-485. Projekt JTAG-lock-pick  tworzony by
 jako rozwi� za-
nie bezkompromisowe i rozbudowane, wykorzystuj� ce wszystkie mo� liwo� ci zastosowanych uk
a-
dów.

Rys. 1: JTAG-lock-pick - uk
ad w obudowie

Interfejs JTAG pozwala na osi� gni� cie cz� stotliwo� ci zegara do 6MHz. Dzi� ki wykorzystaniu magi-
strali USB urz� dzenie mo� na pod
� czy�  do praktycznie ka� dego istniej� cego komputera PC, co nie 
jest mo� liwe przy wykorzystaniu interfejsu równoleg
ego (LPT), który odchodzi ju�  w ca
kowite 
zapomnienie. Dzi� ki zastosowaniu zaawansowanych uk
adów buforuj� cych z serii 74LVC mo� liwa 
jest komunikacja z uk
adami zasilanymi napi� ciami z bardzo szerokiego zakresu – od oko
o 1,6V do 
5,5V.

Jednym z za
o� e�  projektu by
o udost� pnienie zarówno interfejsu UART jak i  RS-232. Wybór po-
mi� dzy interfejsem RS-232 a UART realizowany jest automatycznie na podstawie obecno� ci napi� -
cia zasilaj� cego uk
ady buforuj� ce interfejsu UART – je� li napi� cie to jest wy� sze ni�  oko
o 1,7V 
aktywowany jest interfejs  UART. Cztery najwa� niejsze linie interfejsu  UART (RXD,  TXD,  RTS, 
CTS) s�  równie�  buforowane przez uk
ady serii 74LVC. Pozosta
e linie s�  sterowane bezpo� rednio 
przez uk
ad FT2232 – sygna
y wyj� ciowe maj�  poziom 5V, natomiast próg „logicznej jedynki” dla 

1 http://www.ftdichip.com/Products/ICs/FT2232D.htm  
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sygna
ów wej� ciowych wynosi (typowo) oko
o 1,6V. Dzi� ki doprowadzeniu do gniazda UART sy-
gna
u TXDEN mo� liwe jest do
� czenie do ca
ego uk
adu konwertera RS-485.

Zaprojektowany uk
ad umo� liwia zasilanie uk
adów buforuj� cych – a wi� c i uk
adu docelowego 
(poprzez gniazda JTAG / UART) – napi� ciem 3,3V lub 5V. Szyny zasilaj� ce bufory odpowiedzialne 
za UART i JTAG s�  od siebie rozdzielone, dodatkowa zworka umo� liwia zwarcie ich ze sob� , dzi� ki 
czemu mo� liwe s�  ró� ne konfiguracje napi� ciowe. � ród
em tych napi��  jest szyna USB, maksymal-
ny pobierany przez urz� dzenie pr� d wynosi  500mA dla napi� cia 5V (wg specyfikacji) lub 150mA 
dla napi� cia  3,3V, co jest  warto� ci�  wystarczaj� c�  dla rozbudowanych urz� dze�  cyfrowych bez 
uk
adów mocy.

JTAG-lock-pick  jest programowo w pe
ni kompatybilny z interfejsem JTAGkey2 firmy Amontec, 
dzi� ki czemu w wielu aplikacjach mo� na korzysta�  z gotowych ustawie�  konfiguracyjnych zamiast 
tworzy�  je r� cznie. Mo� liwe jest równie�  wykorzystanie JTAG-lock-pick  do programowania uk
a-
dów  FPGA,  CPLD oraz  AVR plikami typu  SVF przy pomocy oprogramowania udost� pnianego 
przez firm�  Amontec.

JTAG-lock-pick  posiada rozdzielone linie SRST i TRST, które mo� na dodatkowo niezale� nie konfi-
gurowa�  na prac�  w trybie push-pull lub open-drain.

Rys. 2: JTAG-lock-pick - widok na stron�  TOP

Projekt JTAG-lock-pick  jest nast� pc�  projektu 4R|\/|-JT4G Rev023, eliminuj� cym kilka jego wad. 
Przede wszystkim poprzednik mia
 zwarte linie SRST i TRST „z za
o� enia”, co ogranicza
o mo� li-
wo� ci debuggowania. Dodatkowo zastosowany poprzednio uk
ad buforuj� cy 74VHC244 mia
 istot-
n�  wad� , która objawia
a si�  przebiciem napi��  wej� ciowych przez diody zabezpieczaj� ce jego wej-
� cia  na  niepod
� czon�  lini �  zasilania,  co  by
o  bardzo myl� ce,  cho�  ca
kowicie  bezpieczne dla 

2 http://www.amontec.com/jtagkey.shtml  
3 http://www.freddiechopin.info/index.php/pl/projekty/49-arm-jtag-rev01-rev02  
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JTAGa jak i uk
adu docelowego. Obydwa te problemy nie s�  obecne w projekcie JTAG-lock-pick .

Na rysunku 1 przedstawiona jest ca
o��  zamkni� ta w obudowie, natomiast na rysunkach 2 oraz 3 
przedstawiony jest zmontowany uk
ad JTAG-lock-pick .

Rys. 3: JTAG-lock-pick - widok na stron�  BOTTOM

1.1.  Obs
ugiwane uk
ady
Interfejs  JTAG-lock-pick  i obs
uguj� ce go oprogramowanie na komputer  PC (m.in.  OpenOCD, 
Atollic TrueSTUDIO, CooCox CoIDE, Keil MDK-ARM, IAR Embedded Workbench for ARM, Row-
ley CrossWorks for ARM, patrz rozdzia
 4) s�  w stanie komunikowa�  si�  z praktycznie ka� dym ist-
niej� cym typem procesora ARM, w tym z najpopularniejszymi:

� ARM7 (LPC2xxx, AT91SAM7, STR7xx, ...),
� ARM9 (LPC3xxx, AT91SAM9, STR9xx, ...),
� Cortex-M3 (STM32, LM3S, LPC17xx, AT91SAM3, …),
� ...

Jedynym czynnikiem limituj� cym jest obs
uga danego procesora przez oprogramowanie na kompu-
terze PC.

1.2.  „Mocne strony” projektu JTAG-lock-pick
� bezpieczna i bezproblemowa wspó
praca z uk
adami zasilanymi napi� ciami z zakresu od 

oko
o 1,6V do 5,5V, sygna
y buforowane zaawansowanymi uk
adami z serii 74LVC,
� interfejsy UART i RS-232, ka� dy z kompletem o�miu standardowych sygna
ów, cztery naj-



page 6/28 JTAG-lock-pick 1.x.x
Manual PL 2.0 / 120229

wa� niejsze linie interfejsu UART buforowane (oko
o 1,6V do 5,5V),
� mo� liwo��  zasilania uk
adu docelowego napi� ciem 3,3V lub 5V za pomoc�  JTAGa,
� rozdzielone szyny zasilania buforów JTAG i UART,
� ca
o��  zamkni� ta w obudowie, dzi� ki czemu  JTAG oraz pod
� czony do niego komputer i 

uk
ad docelowy s�  zabezpieczone przed przypadkowym uszkodzeniem,
� mo� liwo��  pod
� czenia do uk
adu konwertera RS-485,
� …

1.3.  Zawarto ��  zestawu
� debugger / programator JTAG-lock-pick  (JTAG + RS-232 + UART), lutowany maszynowo, 

przetestowany, zamkni� ty w przezroczystej obudowie (wymiary 24mm x 47mm x 66mm) z 
otworami na gniazda wycinanymi na frezarce numerycznej oraz z gumowymi nó� kami, (ry-
sunek 1, 2 i 3),

� ta�ma przy
� czeniowa JTAG <=> target, 20cm, (rysunek 4),
� ta�ma-przej� ciówka IDC-10 <=> DB-9 (RS-232), 20cm, (rysunek 5),
� dwie wtyczki IDC-14 zaciskane na ta� mie + 20cm ta� my p
askiej 14-to � y
owej do stworze-

nia dowolnego przewodu do interfejsu UART,
� kabel USB mini-B, czarny, 1,8m,
� p
yta  DVD z instrukcj� , sterownikami, kompletem przydatnych programów – darmowych 

(toolchain gcc CodeSourcery, IDE Eclipse, OpenOCD, CooCox CoIDE) i komercyjnych w 
wersjach  testowych (Atollic  TrueSTUDIO for  STM32  Lite,  Keil  MDK-ARM +  CooCox 
CoMDKPlugin,  IAR  Embedded  Workbench  for  ARM +  CooCox  CoIARPlugin,  Rowley 
CrossWorks for ARM) – wszystkie w najnowszych wersjach.
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2.  Hardware

2.1.  Z
� cza

2.1.1.  JTAG
Rozk
ad sygna
ów w gnie� dzie JTAG (przedstawiony w tabeli 1) jest zgodny z tzw. „standardem”.

Tabela 1: Pinologia gniazda JTAG

JVREF – 1 2 – JVREF

nTRST – 3 4 – GND

TDI – 5 6 – GND

TMS – 7 8 – GND

TCK – 9 10 – GND

n/c – 11 12 – GND

TDO – 13 14 – GND

nSRST – 15 16 – GND

n/c – 17 18 – GND

n/c – 19 20 – GND

Linie JVREF s�  liniami zasilaj� cymi bufory (lub docelowy uk
ad, je� li wybrano zasilanie buforów 
ze strony komputera PC). Na rysunku 4 pokazana zosta
a typowa 20-to � y
owa ta� ma po
� czenio-
wa.

2.1.2.  RS-232
Rozk
ad sygna
ów w gnie� dzie RS-232 (przedstawiony w tabeli 2) zgodny jest z kolejno� ci�  stan-
dardow�  w z
� czu DB-9. Zastosowanie ta� my z zaciskanym m� skim gniazdem DB-9 (przedstawio-
nej na rysunku 5) pozwala na uzyskanie pod
� czanego do JTAG-lock-pick  standardowego portu 
szeregowego.

Tabela 2: Pinologia gniazda RS-232

DCD – 1 2 – DSR

RXD – 3 4 – RTS

TXD – 5 6 – CTS

DTR – 7 8 – RI

GND – 9 10 – GND
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Rys. 4: Standardowa ta� ma po
� czeniowa JTAG

Rys. 5: Ta� ma po
� czeniowa RS-232
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2.1.3.  UART
Rozk
ad sygna
ów w gnie� dzie UART (przedstawiony w tabeli  3) jest cz�� ciowo zgodny z gniaz-
dem RS-232.

Tabela 3: Pinologia gniazda UART

DCD – 1 2 – DSR

RXD – 3 4 – RTS

TXD – 5 6 – CTS

DTR – 7 8 – RI

GND – 9 10 – GND

UVREF – 11 12 – UVREF

TXDEN – 1314 – n/c

Linie UVREF s�  liniami zasilaj� cymi bufory (lub docelowy uk
ad, je� li wybrano zasilanie buforów 
ze strony komputera PC).

Interfejs UART z JTAG-lock-pick  mo� na po
� czy�  z uk
adem docelowym za pomoc�  prostej ta� my 
14-to � y
owej (o konstrukcji analogicznej do tej przedstawionej na rysunku 4), ta�my z zako� cze-
niem typu  „flying-leads”  (przyk
ad takiej ta� my przedstawiony zosta
 na  rysunku  6) lub innej – 
dostosowanej do konkretnego zastosowania.

Rys. 6: Przyk
ad ta� my UART z zako� czeniem "flying-leads"
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Dzi� ki obecno� ci w gnie� dzie linii TXDEN, do gniazda UART mo� na pod
� czy�  typowy transceiver 
RS-485 (np. uk
ad MAX485) – w takim wypadku linia ta steruje kierunkiem transmisji.

2.2.  Diody LED
Na p
ytce JTAG-lock-pick  znajduje si�  siedem diod sygnalizacyjnych LED. Ich znaczenie jest na-
st� puj� ce:

� D_USB (zielona), przy gnie� dzie USB – zako� czenie enumeracji urz� dzenia USB, poprawne 
wykrycie JTAG-lock-pick  przez komputer PC,

� D_JVCC (zielona), przy gnie� dzie  JTAG – obecno��  prawid
owego napi� cia zasilaj� cego 
bufory interfejsu JTAG (i uk
ad docelowy),

� D_SRST (� ó
ta), na � rodku modu
u – linia  nSRST jest w stanie aktywnym (stan niski) – 
uk
ad docelowy jest zresetowany,

� D_RS (zielona), przy gnie� dzie RS-232 – brak prawid
owego napi� cia zasilaj� cego bufory 
interfejsu UART, aktywny port RS-232, port UART nieaktywny,

� D_UART (zielona), przy gnie� dzie  UART – obecno��  prawid
owego napi� cia zasilaj� cego 
bufory UART, aktywny port UART, port RS-232 nieaktywny,

� D_RX (� ó
ta), na � rodku modu
u – odbieranie znaku przez interfejs UART / RS-232,
� D_TX (czerwona), na � rodku modu
u – nadawanie znaku przez interfejs UART / RS-232.

2.3.  Zworki
Na p
ytce JTAG-lock-pick  znajduj�  si�  trzy zworki, s
u�� ce do konfiguracji zasilania.  Nieprawi-
d
owa konfiguracja zworek mo� e doprowadzi�  do uszkodzenia JTAGa, uk
adu docelowego lub 
portu USB w komputerze PC! Domy� lnie wszystkie zworki powinny by�  zdj� te.

2.3.1.  Zworka J1 – JVREF
Za
o� enie zworki w pozycj�  oznaczon�  jako 5V lub 3V3 powoduje zasilenie buforów JTAGa (oraz 
uk
adu docelowego za po� rednictwem linii JVREF) napi� ciem (odpowiednio) 5V lub 3,3V. Umo� li-
wia to  debuggowanie uk
adów bez doprowadzania do JTAGa napi� cia zasilaj� cego bufory i / lub 
zasilanie uk
adu docelowego za po� rednictwem JTAGa. Je� li uk
ad docelowy ma w
asne zasila-
nie, które doprowadzone jest liniami JVREF, zworka musi by�  bezwzgl� dnie zdj� ta!

2.3.2.  Zworka J2 – 
 � czenie JVREF i UVREF
Za
o� enie tej zworki powoduje po
� czenie linii JVREF i UVREF, dzi� ki czemu mo� na m.in. zasila�  
bufory UART napi� ciem doprowadzonym liniami JVREF. Je� li do JTAGa zewn� trznie doprowa-
dzone jest zarówno napi� cie JVREF jak i UVREF, nie wolno zak
ada�  tej zworki!

2.3.3.  Zworka J3 – UVREF
Dzia
anie  tej  zworki  jest  identyczne  jak  zworki  J1,  dotyczy  jednak  doprowadzonego  liniami 
UVREF napi� cia zasilaj� cego bufory UART.
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3.  Sterowniki
Pierwsze pod
� czenie  JTAGa do komputera zaowocuje znalezieniem nowych urz� dze�  USB, dla 
których nale� y zainstalowa�  wybrane sterowniki. Zasadniczo dost� pne s�  dwie opcje sterowników:

� opensource'owe sterowniki libusb-win32,
� sterowniki producenta uk
adu FT2232 oparte o bibliotek�  ftd2xx.

Wybór uzale� niony jest od oprogramowania które b� dzie u� ywane do debuggowania przy u� yciu 
JTAG-lock-pick . Obecnie dost� pne w internecie wersje OpenOCD (patrz rozdzia
 4.1) korzystaj�  
z biblioteki  libftdi4, a wi� c wymagaj�  sterowników libusb-win32. Mo� liwa (cho�  skomplikowana) 
jest równie�  samodzielna kompilacja OpenOCD tak aby wykorzystywa
o ono nieco szybsze (w sys-
temie Windows) sterowniki  ftd2xx. 	 rodowisko CooCox CoIDE (patrz  rozdzia
  4.3) oraz wtyczki 
CooCox CoMDKPlugin (dla Keil MDK-ARM, patrz rozdzia
 4.5) i CooCox CoIARPlugin (dla IAR 
Embedded Workbench for ARM, patrz rozdzia
 4.4.2) korzystaj�  ze sterowników ftd2xx. 	 rodowi-
sko Rowley CrossWorks for ARM (patrz rozdzia
 4.6) potrafi wykorzysta�  obydwa rodzaje sterow-
ników.

Archiwum zawieraj� ce obydwie wersje sterowników dla JTAG-lock-pick  znajduje si�  na do
� czo-
nej do zestawu p
ycie DVD w katalogu Drivers. Najnowsze wersje sterowników mo� na znale��  te�  
na stronie firmy  DISTORTEC5 w dziale  Download oraz na stronie  Freddiego Chopina6 w dziale 
Download �  Projekty �  JTAG-lock-pick.

3.1.  libusb-win32
Opensource'owe sterowniki dotycz�  jedynie pierwszego kana
u uk
adu FT2232 – tego który obs
u-
guje interfejs JTAG. W przypadku kana
u dotycz� cego interfejsu UART / RS-232 nale� y zainstalo-
wa�  sterowniki ftd2xx (patrz rozdzia
 3.2).

Zalecana jest instalacja tego sterownika w 
trybie  ca
kowicie  manualnym,  w  którym 
plik sterownika jest wskazywany wprost, a 
nie wyszukiwany przez system operacyjny 
– w trakcie instalacji jest to opcja „Nie wy-
szukuj, wybior�  sterownik do zainstalowa-
nia”  (patrz  rysunek  7).  R� czna instalacja 
jest te�  konieczna w przypadku zmiany ste-
rowników (patrz rozdzia
 3.3).

Prawid
owa instalacja  sterownika sygnali-
zowana jest przez pojawienie si�  elementu 
JTAG-lock-pick – USB <=> JTAG adapter 
w grupie libusb-win32 devices w Menad� e-
rze urz� dze� . Sytuacja ta (po zainstalowa-
niu  sterowników  ftd2xx dla  interfejsu 
UART / RS-232) przedstawiona jest na ry-
sunku 8.

4 Udost� pnianie OpenOCD skompilowanego do u� ycia z „zamkni� tymi”  sterownikami ftd2xx rzekomo narusza 
licencj�  GPLv2

5 http://www.distortec.pl/  
6 http://www.freddiechopin.info/  

Rys. 7: R� czna instalacja sterowników
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3.2.  ftd2xx
Po zainstalowaniu sterowników, w Menad� erze Urz� dze�  systemu powinny pojawi�  si�  nast� puj� ce 
cztery elementy:

� w grupie Kontrolery uniwersalnej magistrali szeregowej: JTAG-lock-pick - USB <=> JTAG 
adapter (jedynie  je� li  dla  kana
u  JTAGa zainstalowano  sterowniki  ftd2xx a  nie  libusb-
win32),  JTAG-lock-pick - USB <=> UART/RS-232 adapter oraz Urz� dzenie kompozytowe 
USB;

� w grupie Porty COM i LPT: JTAG-lock-pick - USB <=> UART/RS-232 adapter (COM xx);

Zawarto��  Menad� era Urz� dze�  po zainstalowaniu kompletu sterowników ftd2xx przedstawiona 
jest na rysunku 9.

3.3.  Zmiana sterownika
Je� li zajdzie potrzeba zmiany sterownika dla kana
u  JTAGa (np. ze wzgl� du na b
� d lub zmian�  
u� ywanej aplikacji), nale� y w Menad�erze Urz� dze�  odnale��  pozycj�  JTAG-lock-pick - USB <=> 
JTAG adapter i dwukrotnie klikaj� c j�  otworzy�  jej w
a� ciwo� ci. Nast� pnie w zak
adce Sterownik 
nale� y u� y�  przycisku  Aktualizuj sterownik..., co spowoduje otworzenie kreatora aktualizacji ste-
rowników. Pami� ta�  nale� y o tym, aby nie pozwoli�  systemowi na automatyczne wyszukiwanie ste-
rowników – skorzysta�  nale� y z opcji „Nie wyszukuj, wybior�  sterownik do zainstalowania” (patrz 
rysunek 7) – gdy�  w przeciwnym wypadku system z du� ym prawdopodobie� stwem zainstaluje po-
nownie t�  sam�  wersj� , nie wprowadzaj� c � adnych zmian.
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4.  Software
W� ród programów w których mo� na korzysta�  z  JTAG-lock-pick  znajduj�  si�  najpopularniejsze 
narz� dzia  dla  procesorów  z  rdzeniem  ARM,  m.in.:  OpenOCD,  Atollic  TrueSTUDIO,  CooCox 
CoIDE, Keil MDK-ARM, IAR Embedded Workbench for ARM oraz Rowley CrossWorks for ARM. 
Korzystanie z JTAG-lock-pick  w tych programach zosta
o szczegó
owo opisane w kolejnych pod-
rozdzia
ach.

Ze strony oprogramowania  JTAG-lock-pick  mo� e by�  u� ywany jako  Amontec JTAGkey. Dzi� ki 
temu u� ytkowanie uk
adu jest bardzo proste – w wi� kszo� ci przypadków wykorzystywane oprogra-
mowanie b� dzie posiada
o gotowe konfiguracje dla tego JTAGa.

4.1.  OpenOCD 7

Podstawowa komenda uruchamiaj� ca OpenOCD powinna wygl� da�  nast� puj� co:

> openocd -f interface/jtagkey.cfg -f target/XXX.cf g

lub
> openocd -f interface/jtagkey.cfg -f board/XXX.cfg

(w zale� no� ci od tego, gdzie zlokalizowany zostanie plik konfiguracyjny dla docelowego urz� dze-
nia / uk
adu).

Dla przyk
adu – wywo
anie  OpenOCD dla uk
adu  STM32 (ARM Cortex-M3) powinno da�  efekt 
zbli� ony do poni� szego (komunikaty zale� ne b� d�  oczywi� cie od wersji  OpenOCD i u� ywanego 
uk
adu docelowego):

> openocd -f interface/jtagkey.cfg -f target/stm32f 1x.cfg
Open On-Chip Debugger 0.5.0 (2011-08-09-23:21)
Licensed under GNU GPL v2
For bug reports, read
        http://openocd.berlios.de/doc/doxygen/bugs. html
Info : only one transport option; autoselect 'jtag'
1000 kHz
adapter_nsrst_delay: 100
jtag_ntrst_delay: 100
cortex_m3 reset_config sysresetreq
Info : clock speed 1000 kHz
Info : JTAG tap: stm32.cpu tap/device found: 0x3ba0 0477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32.bs tap/device found: 0x16410 041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
Info : stm32.cpu: hardware has 6 breakpoints, 4 wat chpoints

OpenOCD mo� na równie�  wykorzystywa�  jedynie do programowania uk
adu docelowego z linii 
polece�  (lub przy u� yciu plików wsadowych / skryptów) przy u� yciu komendy:

> openocd -f interface/jtagkey.cfg -f target/XXX.cf g -c "init; reset 
halt; flash write_image erase YYY.EXT; reset run; s hutdown"

Komenda ta 
� czy w sobie kilka polece�  OpenOCD:

� init – wymagane jest przed kolejnymi komendami „wykonywalnymi” (innymi ni�  konfigu-
racyjne) w linii polece� ,

� reset halt – resetuje i zatrzymuje uk
ad, co jest konieczne przed programowaniem uk
adu,

7 http://openocd.sourceforge.net/  
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� flash write_image erase YYY.EXT – 
aduje do uk
adu zawarto��  z pliku YYY.EXT (gdzie EXT 
to rozszerzenie hex,  bin lub elf), uprzednio kasuj� c pami��  (jedynie obszary które zostan�  
zapisane),

� reset run – resetuje i uruchamia uk
ad, dzi� ki czemu startuje wgrany program,
� shutdown – zamyka sesj�  OpenOCD.

Przyk
ad programowania uk
adu STM32 plikiem stm32_blink_led.hex przedstawiony jest poni� ej.

> openocd -f interface/jtagkey.cfg -f target/stm32f 1x.cfg -c "init; 
reset halt; flash write_image erase stm32_blink_led .hex; reset run; 
shutdown"
Open On-Chip Debugger 0.5.0 (2011-08-09-23:21)
Licensed under GNU GPL v2
For bug reports, read
        http://openocd.berlios.de/doc/doxygen/bugs. html
Info : only one transport option; autoselect 'jtag'
1000 kHz
adapter_nsrst_delay: 100
jtag_ntrst_delay: 100
cortex_m3 reset_config sysresetreq
Info : clock speed 1000 kHz
Info : JTAG tap: stm32.cpu tap/device found: 0x3ba0 0477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32.bs tap/device found: 0x16410 041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
Info : stm32.cpu: hardware has 6 breakpoints, 4 wat chpoints
Info : JTAG tap: stm32.cpu tap/device found: 0x3ba0 0477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32.bs tap/device found: 0x16410 041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
target state: halted
target halted due to debug-request, current mode: T hread
xPSR: 0x01000000 pc: 0x0800024c msp: 0x20000ed0
auto erase enabled
Info : device id = 0x20036410
Info : flash size = 128kbytes
wrote 2048 bytes from file stm32_blink_led.hex in 0 .312500s (6.400 
KiB/s)
Info : JTAG tap: stm32.cpu tap/device found: 0x3ba0 0477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32.bs tap/device found: 0x16410 041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
shutdown command invoked

4.2.  Atollic TrueSTUDIO 8

Wed
ug informacji na stronie producenta pe
na wersja pakietu Atollic TrueSTUDIO wspiera inter-
fejsy oparte o uk
ad FTDI FT2232 (w tym JTAG-lock-pick  dzi� ki kompatybilno� ci z JTAGkey) w 
sposób natywny9. W darmowej wersji Lite dla mikrokontrolerów STM32 mo� na korzysta�  z JTAG-
lock-pick za po� rednictwem OpenOCD (patrz  rozdzia
  4.1), cho�  wspó
praca nie jest bezproble-
mowa. 

Przed przyst� pieniem do konfiguracj�  nale� y skompilowa�  projekt i upewni�  si� , � e stworzony zo-
sta
 plik wynikowy z rozszerzeniem  .elf. W tle nale� y uruchomi�  OpenOCD –  „zewn� trznie” (z 
wiersza polece�  systemu operacyjnego) lub konfiguruj� c je w menu Run > External Tools > Exter-

8 http://www.atollic.com/index.php/truestudio   
9 http://www.atollic.com/index.php/truestudio/targets/jtagdongles/amontec  
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nal Tools Configurations..., przyk
adowa komenda uruchamiaj� ca OpenOCD dla STM32 ma nast� -
puj� c�  posta� :

> openocd -f interface/jtagkey.cfg -f target/stm32f 1x.cfg -c 
"reset_config trst_and_srst"

Konfiguracj�  debuggowania mo� na  przeprowadzi�  za  pomoc�  opcji  Debug  Configurations... z 
menu Run. W nowo otwartym oknie nale� y stworzy�  now�  konfiguracj�  typu  Embedded C/C++ 
Application i skonfigurowa�  w odpowiedniej kolejno� ci nast� puj� ce opcje:

1. w zak
adce Main w pole Project nale� y wpisa�  (lub wybra�  przyciskiem Browse...) projekt 
którego dotyczy�  b� dzie dana konfiguracja, a nast� pnie w znajduj� ce si�  wy� ej pole C/C++ 
Application nale� y wpisa�  (lub wybra�  przyciskiem Search Project... lub Browse...) plik wy-
nikowy projektu z rozszerzeniem .elf; w wi� kszo� ci przypadków pola te zostan�  ustawione 
automatycznie przy tworzeniu konfiguracji;

2. w zak
adce Debugger nale� y wybra�  opcj�  Connect to remote GDB server, a w pole Port  
number wpisa�  warto��  3333, pozosta
e opcje s�  ignorowane – ich warto��  nie ma znaczenia 
i nie nale� y si�  nimi sugerowa� ;

3. w zak
adce  Startup Debug nale� y usun��  ca
�  zawarto��  pola  Initialization Commands i 
wpisa�  tam:

# send "reset halt" to OpenOCD
monitor reset halt
# load application to target via GDB
load
# send "reset halt" to OpenOCD
monitor reset halt
# set temporary breakpoint at main() and resume tar get
tbreak main
continue

4. nale� y zatwierdzi�  wszystkie zmiany przyciskiem  Apply i mo� na od razu rozpocz��  sesj�  
debuggowania klikaj� c przycisk Debug.

Problemy we wspó
pracy pakietu  Atollic TrueSTUDIO w wersji  Lite z programem  OpenOCD to 
m.in.:

� brak mo� liwo� ci  „zresetowania” uk
adu docelowego podczas sesji  debuggowania przyci-
skiem Restart;

� komunikat  systemu operacyjnego o nieprawid
owym zamkni� ciu aplikacji  GDB podczas 
ko� czenia sesji debuggowania;

4.3.  CooCox CoIDE 10

W � rodowisku tym nale� y skorzysta�  z gotowej konfiguracji dla Amontec JTAGkey. Wszelkie opcje 
konfiguracyjne dotycz� ce interfejsu JTAG odnale��  mo� na w menu Debug > Debug Configuration, 
po klikni� ciu na dost� pn�  tam konfiguracj�  dla danego projektu (zwykle b� dzie to nazwa_projektu-
.configuration). Ze znajduj� cej si�  na pierwszej zak
adce (Debugger) w groupboxie Hardware listy 
wyboru Adapter nale� y wybra�  pozycj�  Amontec-JTAGkey i po klikni� ciu przycisku Apply, nacisn��  
przycisk Close.

10 http://www.coocox.org/CooCox_CoIDE.htm   
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4.4.  IAR Embedded Workbench for ARM 11

W pakiecie firmy IAR mo� liwe s�  dwa podej� cia do u� ywania interfejsu JTAG-lock-pick  – mo� na 
korzysta�  z OpenOCD (patrz rozdzia
 4.1) lub z wtyczki CooCox CoIARPlugin.

4.4.1.  OpenOCD
Pierwszym krokiem jest oczywi� cie uruchomienie w tle OpenOCD (przez wiersz polece�  systemu 
operacyjnego) z parametrami odpowiednimi dla danego uk
adu docelowego, zwykle wywo
anie b� -
dzie wygl� da
o mniej wi� cej tak:

openocd -f interface/jtagkey.cfg -f target/XXX.cfg

Nast� pnie w pakiecie IAR Embedded Workbench for ARM w opcjach projektu (Project > Options) 
nale� y wybra�  z bocznego menu pozycj�  Debugger. W zak
adce Setup z listy Driver nale� y wybra�  
pozycj�  GDB Server, a w zak
adce  Download zaznaczy�  opcj�  Use flash loader(s). Nast� pnie z 
bocznego menu nale� y wybra�  pozycj�  GDB Server i w zak
adce GDB Server w pole TCP/IP ad-
dress of hostname [.port] wpisa�  localhost.

4.4.2.  CooCox CoIARPlugin 12

Po instalacji wtyczki w opcjach projektu (Project > Options) nale� y wybra�  z bocznego menu po-
zycj�  Debugger. W zak
adce Setup z listy Driver nale� y wybra�  pozycj�  RDI, a w zak
adce Down-
load zaznaczy�  opcj�  Use flash loader(s). Nast� pnie z bocznego menu nale� y wybra�  pozycj�  RDI i 
w pole Manufacturer RDI driver wprowadzi�  � cie� k�  do pliku CoRDI.dll znajduj� cego si�  w folde-
rze   instalacyjnym  wtyczki  CooCox  CoIARPlugin (zwykle  b� dzie  to  c:\Program 
Files\CooCox\CoIARPlugin\CoRDI.dll, w systemie 64-bitowym u� yty b� dzie zwykle katalog Pro-
gram Files (x86)) oraz zaznaczy�  opcj�  Allow hardware reset. Po zamkni� ciu opcji projektu przyci-
skiem OK w oknie aplikacji pojawi si�  nowe menu – RDI. Nale� y wybra�  jedyn�  aktywn�  w tym 
menu opcj�  – Configure – i w nowo otwartym oknie wybra�  z bocznej listy uk
ad docelowy, a z li-
sty Adapter w groupboxie Adapter Config wybra�  pozycj�  Amontec-JTAGkey.

4.5.  Keil MDK-ARM 13

Korzystanie z JTAG-lock-pick  w � rodowisku Keil MDK-ARM (znanym te�  pod nazwami � Vision 
lub RealView) jest mo� liwe za pomoc�  wtyczki CooCox CoMDKPlugin14. Po zainstalowaniu jej, w 
opcjach projektu (Project > Options for Target 'nazwa_projektu', opcja dost� pna tylko po zaznacze-
niu projektu w oknie Projects) w zak
adce Utilities nale� y z listy wyboru pod Use Target Driver for  
Flash Programming wybra�  pozycj�  CooCox Debugger, zaznaczy�  opcj�  Update Target before De-
bugging, a nast� pnie nacisn��  przycisk Settings. W nowo otwartym oknie nale� y przej��  do zak
ad-
ki  Debug i ze znajduj� cej si�  w  groupboxie USB Adapter listy wyboru  Adapter wybra�  pozycj�  
JTAGkey. Po naci� ni� ciu przycisku OK i powrocie do opcji projektu nale� y przej��  do zak
adki De-
bug i wybra�  znajduj� c�  si�  po prawej stronie opcj�  Use, a z listy wyboru obok wybra�  ponownie 
pozycj�  CooCox Debugger – nie ma potrzeby ponownego ustawiania opcji przyciskiem Settings, 
poniewa�  s�  one wspó
dzielone (zawsze takie same dla zak
adki Utilities i Debug). Poni� ej nale� y 
jeszcze zaznaczy�  opcj�  Load Application at Startup oraz Run to main(). Ca
�  konfiguracj�  nale� y 
zatwierdzi�  przyciskiem OK.

11 http://www.iar.com/en/Products/IAR-Embedded-Workbench/ARM/  
12 http://www.coocox.org/CoLinkGuide/CoIARPlugin.html   
13 http://www.keil.com/arm/mdk.asp  
14 http://www.coocox.org/CoLinkGuide/CoMDKPlugin.html  
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4.6.  Rowley CrossWorks for ARM 15

U� ywanie JTAG-lock-pick  w � rodowisku Rowley CrossWorks for ARM ogranicza si�  do dwukrot-
nego klikni� cia w pozycj�  Amontec JTAGkey w oknie  Targets. Prawid
owe po
� czenie z uk
adem 
sygnalizowane jest na pasku statusu aplikacji oraz wy� wietleniem numeru seryjnego JTAGa i Devi-
ce ID uk
adu docelowego w oknie Properties Window dla Amontec JTAGkey – sytuacja taka przed-
stawiona jest na rysunku 10. W niektórych przypadkach mo� e by�  konieczna modyfikacja parame-
tru JTAG Clock Divider.

Rys. 10: Prawid
owe po
� czenie z uk
adem w � rodowisku Rowley CrossWorks for ARM

15 http://www.rowley.co.uk/arm/index.htm  
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5.  � ród
a dodatkowych informacji
Dodatkowe informacje i pomoc dotycz� c�  JTAGa, oprogramowania,  debuggowania i procesorów 
ARM mo� na znale��  w wielu miejscach w internecie:

� strona firmy DISTORTEC ( http://www.distortec.pl/ ),
� strona Freddiego Chopina ( http://www.freddiechopin.info/ ),
� forum Elektrody ( http://www.elektroda.pl/rtvforum/ ),
� forum SparkFun ( http://forum.sparkfun.com/viewforum.php?f=18 ),
� strona OpenOCD ( http://openocd.sourceforge.net/ ),
� strona pakietu Yagarto ( http://www.yagarto.de/ ),
� strona  pakietu  WinARM (informacje  cz� sto  nieaktualne!)  (  http://www.siwawi.arubi.uni-

kl.de/avr_projects/arm_projects/ ),
� google ( http://www.google.pl/ ).
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6.  Troubleshooting
Problem: Po uruchomieniu OpenOCD pojawia si�  komunikat:

OpenOCD Error: unable to open ftdi device

Geneza: OpenOCD do komunikacji z uk
adem FTDI FT2232 mo� e wykorzystywa�  dwa 
ró� ne sterowniki – „firmowe” ftd2xx lub opensource'owe libusb-win32. Wybór 
sterownika dokonywany jest ju�  na etapie kompilacji OpenOCD. Komunikat taki 
wskazywa�  mo� e na kilka problemów:

1. JTAG nie jest prawid
owo pod
� czony do komputera,
2. JTAG jest „zablokowany” przez inny program lub inn�  sesj�  OpenOCD,
3. Zainstalowane zosta
y niew
a� ciwe sterowniki do JTAGa.

Rozwi� zanie: Ad 1. Skontrolowa�  po
� czenie JTAG <=> PC.
Ad 2. Zamkn��  pozosta
e sesje OpenOCD lub inne programy po
� czone z 
JTAGiem.
Ad 3. Odinstalowa�  niew
a� ciwy i zainstalowa�  w
a� ciwy sterownik (patrz rozdzia
 
3.3).

Problem: Próba programowania / debuggowania uk
adu w pakiecie CooCox CoIDE ko� czy 
si�  b
� dem o tre� ci:

Target Chip not found

Geneza: Pakiet CooCox CoIDE w wersji 1.4.0 (najnowsza w chwili pisania tego 
dokumentu) nie wspó
pracuje prawid
owo z JTAGami opartymi o uk
ad FTDI 
FT2232.

Rozwi� zanie: Nale� y u� y�  wcze� niejszej wersji 1.3.0 lub przetestowa�  nowsze wydania gdy 
zostan�  one udost� pnione.
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7.  Manual changelog
1.0 (19.08.2009)

1.1 (29.08.2009) 1. Zmiana informacji o lokalizacji sterowników libusb-win32 – obecnie 
sterowniki te nie s�  do
� czane do OpenOCD, na stronie dost� pna jest 
paczka z obydwoma wersjami sterowników dla JTAG-lock-pick

2. Dodana informacja o podforum OpenOCD na forum SparkFun

1.2 (15.03.2010) 1. Drobne poprawki
2. Dodanie informacji o wersji 1.1 projektu (rozdzia
 Hardware changelog, 

aktualizacja zdj�� , dodanie schematu i listy elementów)
3. Dodanie dwóch zrzutów ekranu z systemowego Menad� era Urz� dze�  do 

rozdzia
u o finalnych sterownikach
4. Aktualizacja zawarto� ci konsoli po wywo
aniu OpenOCD w wersji 0.4.0

1.3 (26.12.2010) 1. Drobne poprawki
2. Dodanie informacji o wersji 1.1.1 p
ytki
3. Opis programowania EEPROMu w programie FT_Prog
4. 	 rodowisko Rowley CrossWorks for ARM: informacja o obs
udze 

sterowników libusb-win32, aktualizacja obrazka
5. Wiele komend przekazywanych do OpenOCD poprzez „-c”  po
� czono w 

jeden 
a� cuch, elementy rozdzielone � rednikami

1.3.1 (10.12.2011) 1. Drobne poprawki
2. Doprecyzowanie informacji o tym kiedy trzeba instalowa�  sterowniki 

„bazowe” i programowa�  EEPROM

2.0 (29.02.2012) 1. Poprawki wi� kszo� ci opisów
2. Usuni� cie informacji o elementach i o wersjach JTAGa (dost� pna jest 

tylko zmontowana wersja FULL)
3. Dodanie obs
ugiwanych uk
adów, „mocnych stron” i zawarto� ci zestawu
4. Usuni� cie informacji o sterownikach „bazowych” i programowaniu 

EEPROMu (dost� pne wersje maj�  zaprogramowany EEPROM)
5. Dodanie informacji o zmianie sterowników
6. Dodanie informacji o innych aplikacjach obs
uguj� cych JTAG-lock-pick
7. Usuni� cie schematu i listy elementów dla wersji 1.0 (dost� pna jest tylko 

wersja 1.1)
8. Dodane t
umaczenie na angielski
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8.  Hardware changelog
1.0 (19.02.2009)

1.1 (31.01.2010) Schemat:
1. Drobne poprawki
2. Uk
ad  LP2980 (50mA max) zast� piony uk
adem  LP2985 (150mA max) 

(uk
ady s�  wzajemnie kompatybilne)
3. Zmiana  kolejno� ci  diod  i  rezystorów w dwóch po
� czeniach  (zamiast 

dioda-rezystor jest rezystor-dioda) – diody D_UART i  D_RS s�  bardziej 
odsuni� te od gniazd IDC, dzi� ki czemu s�  lepiej widoczne

4. Warto��  drabinki rezystorowej RA4 zmieniona z 4 x 10kR na 4 x 100kR
P
ytka PCB:

1. Drobne poprawki
2. Usuni� cie  wszystkich  po
� cze�  „wprost”  mi� dzy  s� siednimi  padami 

(przy uk
adzie MAX3243 i przy drabinkach rezystorowych 4 x 100kR)
3. Dopasowanie mechaniczne p
ytki do rzeczywistych wymiarów obudowy 

Z-24A (umiejscowienie  otworów  monta� owych,  gniazda  IDC-20 oraz 
diod D_USB i D_JVCC)

4. Cofni� cie gniazd IDC „w g
� b”  p
ytki

1.1.1 (22.11.2010)P
ytka PCB:
1. Dopasowanie po
o� enia otworów monta� owych do opublikowanych (w 

ko� cu) dok
adnych rysunków technicznych obudowy Z-24A
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9.  Appendix
� schemat uk
adu (wersja 1.1), str 24
� lista elementów (bill of materials) (wersja 1.1), str 27
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9.1.  Schemat uk
adu (wersja 1.1)
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9.2.  Lista elementów (bill of materials) (wersja 1 .1)
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